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6 Graphical User Interface 
 
The THEMIS Graphical User Interface (GUI) provides a powerful interface to THEMIS science data. It is designed for ease 
of use in viewing and analyzing data and is set in a familiar windows-like environment. Features include the ability read, 
load, and view data, create publishing quality plots, access commonly used THEMIS analysis software, and increased user 
interaction. 
 
The GUI code is bundled together with the THEMIS IDL code distribution; they are downloaded and installed as a single 
package. 
 
A text-only version of the documentation for the GUI is available within the software distribution at 
idl/themis/examples/thm_gui.txt. 
 

6.1 Main Window Overview 
 
The main GUI window is shown below in Figure 6.1. This is a snapshot of the window when the GUI is first started. Since 
no data or THEMIS GUI document has been loaded and no plots created, the main graph area will be blank. 
 
Starting from the top of the window is the windows frame titled. THEMIS: Main Window. It has the standard window 
features in the frame to minimize, maximize, and close the window. 
 
Below the frame is the main menu bar. Commonly used menus include File, Edit, View, Page, and Help. Specific to the 
THEMIS application are Graph and Analysis pull down menus. 
 
Next, below the main menu bar is the toolbar. For quick and easy access to the most frequently used functions, the toolbar 
contains icon buttons the user can click on versus navigating through the pull down menu hierarchy.  All icon buttons in the 
toolbar contain tooltips to provide the user with a brief description of the functionality.  
 
Below this is the horizontal scroll bar, which allows you to pan left and right along the x-axis of any displayed data.. 
 
The large central area of the main window contains the graph area and is where plots are displayed. To the right of the graph 
area is a scroll bar that allows the user to scroll vertically when multiple plots are displayed.(Unlike the horizontal scroll bar, 
this scrolls across the images, but doesn't change the range of displayed data).   If the view is zoomed in sufficiently, a scroll 
bar will also appear on the bottom of the graph area which, like the vertical scroll bar, will allow scrolling across the 
displayed images, but not change the range of the displayed data. 
 
And, finally, at the bottom of the window is a message bar. The message bar updates the user on the state of the GUI, the 
status of an operation, and provides general information to the user, including warning and/or error messages. 
 
 

6.1.1 Pull Down Menus  
 
Pull down menus use standard features that users are familiar with and including the following: 
 
Sensitive:  A menu item may be sensitized or desensitized (grayed out) depending on the state of the GUI and/or the 
availability of an operation at the time it is requested.  
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Checked:  Check marked menu items are used when an option can be turned on or off. The check mark allows the user to 
toggle on or off an item.  
 
Sub:  In cases where multiple options are available, a sub menu is used to further divide the functionality.  Submenus will 
have a carrot or arrow head indicating there are additional options to select from. 
 
Dynamic:  One menu, the Page menu, is not static and changes with the number of pages that have been created.  
 
Pop-Up:  In cases where a menu item displays another window, the name of the item will be following by three periods.   
 
Accelerator:  Some menus have accelerator keys associated with them. Accelerator keys provide a quick and easy way to 
invoke functions. When a menu item has an accelerator key, the key combination will be listed next to the name of the menu 
item.  
 
An example pull down menu is shown below in Figure 6.1.1.  
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6.1.2 Toolbar icons 
 
The toolbar provides short cuts to more commonly used functions. The buttons contain familiar icons depicting the operation. 
In addition, each tool bar button contains a tool tip that is displayed when the cursor hovers over the button. The tool tip 
displays text describing the function of the button. Buttons are clustered when their functionality is similar. Figure 6.1.2 
shows a picture of the tool bar.  
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6.1.3 Graph Area 
 
Shown below, in Figure 6.1.3, is an example of the main graph area with a graph plotted.  
 

 

 
 

6.1.4 Status Bar 
 
The status bar is located below the main graph area and displays messages to the user. Messages include status updates, state 
of the GUI and/or operation, success and failure notices, as well as warning and error information. It is important for the user 
to remember to check the status bar periodically for messages, particularly if you think something is not correct.  Information 
displayed in this bar may be helpful and provide an answer to your question.  
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Please note, when a severe error or incorrect usage occur you will be notified via a pop-up dialog window explaining the 
error.  Additional instructions may be provided.  
 

6.1.5 Buttons 
 
In order to provide a consistent interface throughout the GUI, you will find most windows contain the set of buttons shown in 
Figure 6.1.5.  
 
 

 
 
OK: When this button is clicked whatever changes you made since the window was first displayed will be made, committed 
within the system. The window will be closed and the main graph area will be updated to reflect the changes. Please note that 
when OK is selected the original settings will be lost. 
 
Apply: The apply button will update the main graph area so that you can view your changes. The window will not be closed 
and your changes will not be committed. 
 
Cancel: Whenever the cancel button  is clicked all changes made since the window was first invoked will be reset to original 
settings. The window will be closed. The main graph area will be updated to reflect it’s original state. You should note that 
like the OK button, when the cancel button is selected all changes are lost permanently.  
 

6.1.6 Windows 
A window within the GUI refers to any windows that is opened when pull down selections are made, a tool bar button is 
clicked and other user interactions. Windows have frames, titles, and minimize, maximize, and close buttons within the 
frame. Most windows are also modal. That is, the user must either click the OK or Close button, or the Cancel button ‘X’ in 
the window frame before control is returned to the calling or original window.  
 
NOTE:  Screen size and system settings vary from machine to machine. During testing, a rare case was found that opened 
some IDL windows to size zero. The windows included the dialog box pick file and printer setup used in the File pull down 
menu. This is an error internal to IDL. If a window opens to size zero, you simply need to resize to see the content.    
 

6.1.7 Pages 
The user can have one or many pages during a session. A page contains one or many panels, titles, background color, etc. 
The number of pages that have been created can be determined by using the Page pull down menu. The Page pull down menu 
also provides a way for the user to toggle between pages since only one page can be displayed at a time. 
  

6.1.8 Panels 
 
A panel is a plot or graph on a page. Panels are usually contained within an axis frame and have x and y axes (and z axes for 
spectral data), traces, ticks, gridlines, and other features. One or many panels can be created per page.  
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6.1.9 Color Palette 
 
Most of the Graph Options windows allow the user to change the color of labels, traces, background, grid, annotations, and 
more. Whenever color can be modified, a Color Button (with a color palette icon) and Color Swatch with the current color 
setting will be available. An example of the Color Button and Current Color Swatch and shown in Figure 6.1.9a.  
 

 
 
 
 

When the color button is clicked a Color Palette window is displayed.  The user can select a color by clicking on the color 
tiles or by using the RGB slider bars below the tiles. When a selection has been made the current color swatch in the middle 
of the window will be updated to reflect the new color. You can choose to accept the color by clicking on the Accept Button 
or choose not to make any changes by clicking on the Cancel Button. Both the Cancel and Accept buttons will close the color 
palette window and return to the original or calling window. If the user accepted the color, the current color swatch in the 
original window will be updated. The color palette window is shown in Figure 6.1.9b.  
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Figure 6.1.9a 
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The Color Palette window is a modal window and you must either make a selection or cancel the window in order to return 
control to the calling window.  
 

6.1.10 Data Tree 
 
All data that have been loaded directly into the GUI or imported from tplot variables are displayed in a tree widget. Many of 
the GUI windows require the user to select data for analysis or plotting and will be displayed in tree format. The tree widget 
allows the user to expand or collapse the tree by clicking on the ‘+’  (expand) or ‘-‘ (collapse) buttons next to the data. The 
data tree hierarchy is as follows: 
 

Mission 
Observatory 
Instrument 
Data Group 
Data Components 

 
An example of a data tree is shown below in Figure 6.2.9.  
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6.2 Mouse and Keyboard Events 

6.2.1 Tracking 
 
When tracking is enabled any movement within the frame of a panel in the draw area will be tracked. Tracking can be 
toggled on and off from the Graph pull down menu. The user can choose to track one panel or all panels. In addition the user 
can track vertically, horizontally or both. When the GUI session is first started, tracking of all panels is on by default and 
tracking both vertically and horizontally. Figure 6.2.1 shows an example of the main graph area when tracking is turned on 
and tracking all panels.  Changing the tracking settings will affect what information is displayed in the legend, and which 
panels the legend is displayed on. 

Mission 
Observatory 
Instrument 
Data Quantity 

Data 
Components 

Instrument 
 

Figure 6.1.10 
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6.2.2 Legend 
 
When tracking is on a legend will be appear in the upper right corner of each panel that is being tracked. The values of each 
data point intersecting the vertical tracking line are displayed. See Figure 6.2.1 above. The user can choose to turn the 
position legend on or off by toggling the Position Legend under the View menu. The legend is on by default.  If only one 
panel is being tracked, then only one panel will have a legend. Please note that if you have the position legend on and choose 
the print option, the legend will not appear in the plot so that the user can view the entire panel. 

6.2.3 Mouse Clicks 
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Figure 6.2.1 
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The mouse button offers several ways to interact with the GUI and the graph area. Mouse clicks include Single Click (left 
button), Right Click, Ctrl-Click-Drag, and Click-Drag. 
 
Single Click: 
There are two possible events that a single click will generate. One is when marker(s) are present and the user clicks within 
the highlighted area of a marker, the other is when the user clicks outside of a marker but within the graph area. Markers will 
be explained shortly in Section 6.2.5. For now, we will describe a single click in the graph area, which brings up a graph 
options menu window. Which graph options window is displayed depends on where within the graph area the mouse button 
was depressed.  
 
There are 5 options. 
 

Page: Any area that is outside of a panel, axis, label, or variable display will bring up the Page Options Window. In 
the event the GUI cannot determine which object was clicked, the Page Options Window will be opened. 
Panel: When the user clicks within the frame of any panel, the Panel Options window is displayed 
X-Axis: When the user clicks on the X Axis the Axis Options panel is displayed. 
Y-Axis: When the user clicks on the X Axis the Axis Options panel is displayed. 
Variables: If variables are present the user can click in the variable display area to open the Variable Options 
window. 

 

 
 

Single Click in 
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Figure 6.2.3a 
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Please note that resolution and screen size vary between machines and platforms. If you click close to another option in the 
draw and do not get the window you wanted, try clicking more in the middle of the area you want. 
 
Right Click: 
Clicking the right mouse button will bring up a context menu containing the most commonly used options associated with 
plotting and data analysis.  The context menu contains the following menu items. 

 
 
 

6.2.4 Keyboard Events 
 
There are two kinds of keyboard events, scrolling and expanding/reducing.   
 

Right Click 

Context Menu 

Figure 6.2.3b 
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Scroll: The user can scroll the panels in the active page forward or backward by using the left and right arrow keys. The plot 
will be moved forward or backward in time by one major tick length. 
 
Reduce/Expand: The panels can also be reduced or expanded by using Backspace or Tab keys. Tab will expand the panels 
horizontally by two major tick lengths (one major tick length is added to both the left and right sides of the x axis). Similarly, 
Backspace will reduce the panels displayed by two major tick lengths.  
 
Accelerator Keys: Standard accelerator keys are available for the more frequently used functions. Accelerator keys include 
 

Ctrl-O – Opens an existing THEMIS GUI Document 
Ctrl-S – Saves a THEMIS GUI Document 
Ctrl-Z – Close page 
Ctrl-P – Print page 
Ctrl-Q - Quit 
Ctrl-R - Refresh 
Ctrl-C - Copy 

 

6.2.5 Markers 
 
Marking is a new feature that allows the user to mark or select regions of interest in panels on the active page. If tracking is 
set for all panels then all panels will be marked. Likewise, if only one panel tracking is set, then only the panel the cursor is in 
is marked. Marker ranges are selected horizontally or along the x-axis, using the vertical tracking line as the boundary.  The 
y-axis range is preserved.  
 
A Ctrl-Click-Drag operation is used to create a marker. To do this, hold the Ctrl key while depressing the mouse button and 
dragging the mouse. The user can click the mouse button or the Ctrl key in any order, marking will not start until the Ctrt key 
is pressed and cursor movement is detected. Marking ends when the user releases the mouse button.  When you are finished, 
the marked area will be highlighted.  If the cursor leaves the draw area, marking will be canceled. Figure 6.2.5 shows 
examples of two markers, one created while all panels were being tracked, the other with only one panel tracking.  
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There are several things worth noting about the marked regions shown in Figure 6.2.5. First, note that all three markers have 
boundary lines drawn in different colors. The current state of the marker is color coded.  
 
Green: Indicates that the cursor is currently within the marker 
Blue: Indicates the user has clicked the mouse button within that marker to make it ‘Active’ or the currently selected marker. 
Only one marker can be active at a time. 
Red: Represents all other markers (not active or the cursor is not within its area. 
 
When a marker is ‘active’ (blue boundary lines) there are additional functions you can perform on the marker. You can 
choose to delete the marker or zoom into the marked area.  
 
To delete a marker select the Delete Marker option under the Edit pull down menu. 
 
To display only the marked area, select the Subset option under the Edit pull down menu. A new page will be created and 
displayed containing only the marked area. The original page is preserved. You can use the Page pull down menu to see your 
new page name and to move between pages or back to the original page. Marked areas are preserved and will not be lost 
when navigating between pages. 

Cursor in marker 

Marker 

Selected Marker 

Figure 6.2.5 
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6.2.6 Data Zoom 
 
Besides zooming in on marked areas, the user can also click and drag the mouse to zoom into a selected area. While 
markers&expand/reduce preserve the y axis range, the click and drag does not.  
 
To zoom into an area depress the mouse button and drag the cursor. You will note that as you move the cursor and 
rectangular area is drawn on the panels. A corner of the rectangle is pinned as soon as you press the mouse button and cursor 
motion is detected. This rectangle is referred to as a rubber band box and can be moved in any direction. If the cursor leaves 
the draw area the zoom will be canceled. Figure 6.2.6a shows an example of a selected area. 

 

 
 
Once you are happy with the area you have selected you can release the mouse button. When the mouse button is released a 
new page will be created and the panel(s) redrawn with the x and y ranges contained in the rectangular area. Panels not 
contained in the rectangle will not be redrawn. Similar to the Subset Marker option, the original page prior to the zoom 
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operation is preserved. The Page pull down menu on the main GUI allows you to toggle between the two pages.  Figure 
6.2.6b shows the new page that was zoomed into.  
 
 

 

6.2.7 Zoom In/Out 
 
In addition to zooming into marked regions and/or rectangular areas the user can also choose to modify the size of the visible  
area by using the zoom spinner widget on the toolbar. The zoom spinner allows the user to increase or decrease the size of the 
visible region by entering a percent value of the original page size.  The user should be aware that when zooming in and out 
of the page, the main graph area will not change in size, only the page will. You can see this in Figure 6.2.7, which shows an 
example of decreasing the page size by 50%. 
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6.3 File Menu 
 
The file menu contains selections that are related to loading, saving, and managing data, as well as printing and exporting 
image files. Figure 6.3 shows all options in the File pull down menu. 
 

Figure 6.2.7 
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6.3.1 Open THEMIS Document 
 
The THEMIS GUI now includes the capability to (partially) save the state of a GUI session to a file we'll refer to as a 
"THEMIS GUI Document" (with default file extension of TGD). TGD files are plain ASCII text, use XML to represent 
properties of GUI objects and loaded data, and can be examined with any ASCII file editor.  Many web browsers also include 
support for viewing XML documents (although one may need to change the file extension to XML to get the browser to 
recognize the format).  
 
As of TDAS release 5.00, any loaded data associated with a GUI session is NOT directly stored in the TGD file; instead, the 
document contains the information necessary to reconstruct the sequence of calls that were initially used to load the data.  
There are some pros and cons to this approach that users should be aware of: 
 

1) TGD files are relatively small, and can be easily shared as email attachments.  Because they are plain ASCII text, 
there are no significant file format differences between different platforms, so TGD files are portable between 
systems. 

2) Opening a TGD file may require internet connections to THEMIS data servers in order to download any data files 
that are not already cached in the user's local file system. 

3) Since the TGD file only records operations performed within the GUI.  Operations performed outside the GUI or 
data that is imported via manage data or tplot_gui will not be recorded in the THEMIS Document. 

4) Opening a TGD file is a DESTRUCTIVE operation that wipes out the current window configuration and loaded 
data, replacing it with the contents of the TGD file.  We recommend that users save their work before opening a new 
TGD file, and pay attention to any warning dialogs to avoid nasty surprises. 

Figure 6.3 
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5) No versioning information is stored in the XML file, TGD files created under a particular version may not be 
readable in other versions.  Although, since the GUI interfaces are more stable than they were originally , this is 
less of a problem in recent releases. 

 
To open a TGD file, select "Open THEMIS Document…" from the File pull-down menu. This will bring up a pop-up dialog 
warning of the potentially destructive consequences of opening the file; if you're sure you want to proceed, click "OK" to 
dismiss the warning pop-up.  

 
A file picker dialog will appear.  Its appearance and exact functionality will depend on your platform; on Windows XP, this 
is what it looks like: 
 

 
 
Navigate to the file you wish to open, and click "Open" (or perhaps "OK", depending on your platform). 

 
This should trigger the process of loading the data specified in the TGD file you just opened; you should see progress 
messages scrolling by in the IDL command window.  It may take several minutes to load all the data, depending on how 
complex a document is being loaded; TDAS may also need to open an internet connection to the THEMIS data servers to 
download any data files not already cached on your local file system. 
 
If all goes well, when the data is finished loading, the main draw window should update and show the plots for the first GUI 
window specified in the TGD file.  Other windows saved in the TGD file should be accessible through the "Window" drop-
down menu button.  Any errors detected while parsing the XML file or loading the data will be reported by a pop-up error 
dialog, or a message in the status area at the bottom of the main GUI window. 
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6.3.2 Save THEMIS Document 
 

Please refer to the caveats in section 6.3.1 regarding what is and is not represented in the THEMIS GUI Document 
format, particularly regarding coordinate transforms, data processing operations, and operations performed outside 
of the THEMIS GUI.  We recommend a workflow something like this: 

 
1. Use the "Load THEMIS Data" dialog to load the all the data you want to work with 
2. Use the "Window" menu and "Graph->Plot/Layout options…" dialog to create some plots 
3. Use "Save THEMIS Document" to save the window configuration, plot properties, and loaded data call sequence 

information, creating a "checkpoint" that can easily be restored later 
4. Perform any other manipulations (coordinate transforms, data processing routines, non-GUI operations), and be 

prepared to repeat them after opening the TGD file at some later time to restore the check pointed GUI configuration. 
 
When you're ready to save your plots and loaded data, click "Save THEMIS Document" under the File pull-down menu.   All  
pages, plot settings, data, and data operations will be saved. If this session has not yet been saved to a TGD file, a platform-
specific file-saving dialog will appear.  On Windows XP it will look something like this: 
 

 
 

 
 

Figure 6.3.2 
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Navigate to the directory where you'd like to save the file, select a new filename if you don't like the default, and click "Save" 
(or maybe "OK", depending on your platform). 
 
If "Save THEMIS Document" has already been invoked, or if the current session is the result of loading a TGD file, the file 
picker dialog will not appear, and the filename from the most recent save or open operation will be used again. 
 
If the file already exists, a pop-up will appear to warn that you're about to overwrite an existing file.  If you choose to 
proceed, the "save document" routine will try to confirm that you have write permission before attempting the save.   
Warning: Due to an IDL bug on Windows platforms, the condition "write permission denied" is not properly 
detected, and will probably crash your entire IDL session if you attempt to save to a file without write permission.  
This IDL bug does not appear to affect Unix, Solaris, or Mac users. 
 
If the save attempt fails, an error message should be displayed, either in a pop-up warning dialog, or a message in the status 
area at the bottom of the main GUI window.  If the save succeeds, a success message will appear in the status area. 
 
Hint: The THEMIS document can also be used to save default plot settings. Once you have created the font, size, colors, 
grids, axes, etc. that you prefer, the save document option will preserve those values. Each subsequent time  you start a GUI 
session, you simply need to open the saved document to restore your preferences. 
 

6.3.3 Save As… 
 
The File->Save As… dialog also saves a TGD file.  The only difference between "Save THEMIS Document" and  
"Save As…" is that "Save As…" always pops up a file picker dialog, allowing one to change the filename associated with the 
GUI session.  "Save THEMIS Document" will reuse the last filename successfully saved to, only displaying a file picker the 
first time the GUI state is saved. 
 
See the documentation for "Save THEMIS Document" in section 6.3.2 for more information about saving TGD files. 
 

6.3.4 Close Page 
 
The THEMIS GUI allows the user to have multiple pages.  If you wish to close a page there are several ways this can be 
done. The first is using the File pull down menu and selecting the Close option. The currently displayed page, or the ‘active’ 
page will be closed. Other pages will still be available. The main graph area will redraw the next page up in the list, unless 
there are no more pages, in which case a blank graph area will be drawn. In addition, the Page pull down menu dynamic 
options will be updated and renumbered to reflect the change.  
 
Besides the file pull down menu, you can also type Ctrl-Z or select the Close option under the Page pull down menu.   
 
It should be noted that once a page is closed the settings that were associated with that page will be lost, unless you requested 
Save THEMIS Document under the File pull down menu before you closed the page. The data that was plotted in the page 
still remain are available for analysis and plotting. Only the plot settings are deleted. 
 

6.3.5 Load Data 
 
The Load Data option, under the File pull down menu, opens a window that allows the user to select specific data sets to be 
loaded into memory.  Four missions are available for loading data and include THEMIS, GOES, WIND, and ACE data. 
There is also a tab for loading THEMIS particle spectra. 
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6.3.5.1 THEMIS Data 
The left hand side of the window contains the data selection area and the right hand side of the window displays data that has 
already been loaded 

 

 
 
 
 
Data can be removed at any time by making a selection in the data tree and clicking the trash can.  The data tree will be 
updated to reflect the deletion.  The user can also use the Clear All button below the data tree to delete all data.  
 
At the bottom of the window is a status bar.  Messages regarding the load process, data, and/or status of the window will be 
displayed here. 
 
When you have loaded all the data you want, click the Done button below the data tree. 
 
Each different mission supported by the THEMIS GUI has separate configuration parameters.   In the GUI you can control 
configuration for each mission by  editing the settings in the File->Configuration Settings Menu. For more see Section 5.3 
Installation and Configuration. 

6.3.5.2 THEMIS Derived Spectra 
By selecting the THEMIS Derived Spectra tab a different window is displayed, This window provides an interface to the 
TDAS routine “THM_PART_GETSPEC”, which is described in section 5.5.3.4. THM_PART_GETSPEC Operates on Level 
1 SST and ESA data only. For each data type, (e.g., peif, peef, psif, psef, etc...) all of the L1 data must be loaded. For ESA 

Figure 6.3.5 
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data, this is done automatically when a data type is chosen from the Load THEMIS Data widget. For SST you need to click 
on all L1 variable choices for each given data type when loading. Be sure that all of the appropriate data is loaded. For pitch 
angle and gyro-velocity distributions, FGS and STATE data for the appropriate probes are also necessary. These will be 
automatically loaded if they have not been loaded already. 
 
The top window on the left side allows you to choose a suffix for the new variables that are created. 
The drop-down menu below this allows you to choose the type of angular particle distribution to create. The choices are 
“PHI”, in degrees relative to probe-sun direction in spin plane, “THETA”, in degrees relative to spin plane or the azimuth for 
pitch angle distributions, “PA”, for pitch angle, degrees relative to the magnetic field, and “GYRO”, for gyro-velocity 
distributions. (See section 5.5.3.4 for details about the various angular choices.) 
 
The set of windows below allows the user to set minimum and maximum values for the different angular ranges, and a start 
angle for the PHI option. Below these are windows allowing the user to set energy and time ranges.  In the energy range box, 
there is a check box labeled “Return Energy Spectrum”; if this is checked, then the process will create an energy spectrum for 
the data integrated over the full angular range. 
 
On the right side there is first a check-box labeled “Normalize Spectrum”, if this is checked, then the spectra are normalized. 
The windows below allow you to change the number of points used to re-grid the angular data for interpolation. The 
dropdown below this allows you to change the default value for the second axis for conversion to field-aligned coordinates, 
used for pitch angle and gyro-velocity distributions. The next window allows you to specify the maximum gap in seconds 
over which data are interpolated.  
 
The options below this are all restricted for use for SST data, if the check-box for SST mask removal is checked, then the 
value in the box below this will be the proportion of values that need to be zero at a given time for the program to decide that 
a mask is present.  If the box for SST Sun Contamination is checked, then the drop-list menu below can be used to choose the 
sun pulse cleaning method for contamination removal. The window below this is used for the value of the standard deviation 
tolerance for sun pulse cleaning, and finally the drop-list menu below this allows you to specify the default method for filling 
in points that are removed; either “INERPOLATION” or “SPIN_FIT”. For a more detailed explanation of the input 
parameters, please see section 5.5.3.4. 
 
To initiate the process, click the “Apply” button. New variables are created, and appended with the input value for the suffix. 
For example, if “tha_psif” data is used with the “PHI” option set, the angular spectrum will have the name 
“tha_psif_an_eflux_phi_part_spec” and if the energy spectrum is calculated then this variable will have the name 
“tha_psif_en_eflux_part_spec” as shown here. 
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6.3.5.3 GOES Data 
Selecting the GOES Data tab displays a window similar in form to the THEMIS Data tab, however, this tabbed windows is 
specific to down loading GOES data. The user can select a time frame, the probes, and parameter types.  Once the user has 
made their selections, to download and import data into the GUI memory, click on the right arrow key, in between the GOES 
Data Selection Area and the Data Loaded area. An hourglass will appear while data is being loaded. If the user chooses to 
delete data, they can select the variable name from the data loaded window and click the trash can. 
 

Figure 6.3.5.2 
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6.3.5.4 WIND Data 
Selecting the WIND Data tab displays a window similar in form to the THEMIS Data tab, however, this tabbed windows is 
specific to down loading WIND data. The user can select a time frame, the instrument type, data type, and parameter types.  
Once the user has made their selections, to download and import data into the GUI memory, click on the right arrow key, in 
between the WIND Data Selection Area and the Data Loaded area. An hourglass will appear while data is being loaded. If the 
user chooses to delete data, they can select the variable name from the data loaded window and click the trash can. 

Figure 6.3.5.3 
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6.3.5.5 ACE Data 
Selecting the ACE Data tab displays a window similar in form to the THEMIS Data tab, however, this tabbed windows is 
specific to down loading ACE data. The user can select a time frame, instrument type, data type, and parameter types.  Once 
the user has made their selections, to download and import data into the GUI memory, click on the right arrow key, in 
between the ACE Data Selection Area and the Data Loaded area. An hourglass will appear while data is being loaded. If the 
user chooses to delete data, they can select the variable name from the data loaded window and click the trash can. 
 

Figure 6.3.5.4 
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6.3.6 Save Data As… 
 
The "Save Data As…" dialog allows the user to select a set of variables, and save the data as ASCII (with various formatting 
options) or as a set of files in the UCLA binary "upper flat file" format.  Unlike "Save THEMIS Document" or "Save As…", 
"Save Data As…" does not attempt to save any GUI objects or plotting parameters. 
 
Click "File->Save Data As…" to bring up the dialog.  On Windows XP, it will look something like this, assuming some data 
has already been loaded: 

Figure 6.3.5.5 
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The left hand "Loaded Data" pane is a "tree widget" representing the data variables currently available.  In the above screen 
shot, many of the nodes are fully expanded.  Click any box showing "+" to expand that node, or click a box showing  
"-" to collapse that node.   
 
To the right of the "Loaded Data" pane are some additional controls.  If the "Restrict Time Range" box is checked, only the 
data with timestamps in the given time range will be saved.   For now, the start and end times must be typed into the text box 
in YYYY-MM-DD/HH:MM:SS format.   
 
If the "Save as Flat file" box is checked, the data will be saved in (binary) UCLA flat file format.  There are actually two 
formats available (upper/lower, or top/bottom in this dialog), but for this release, only the upper flat file format is supported. 
For further information about this format, please consult the UCLA documentation. 
 
If the "Save as ASCII data file" box is checked, the data will be saved as ASCII, one line per record.  If this format is 
selected, there are additional choices for how the ASCII data is formatted.  The "Time Format" drop-down menu brings up a 
list of different formats for representing timestamps with varying degrees of precision.  The "Floating Point Format" drop-
down menu specifies the precision and format of floating point quantities that are not internally marked as timestamps. 
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The "Header Style" drop-down menu offers a few options for including header lines in the ASCII output.  If "None" is 
selected, no header will be produced; for "Field Names Only", a single header line will be included, listing the field names 
associated with each data column; for "Tecplot", a Tecplot-compatible header will be produced with one line of field names, 
and another line with a sample count and some other information. 
 
The "Item Separator" drop-down menu allows the user to select whether columns are to be separated by commas, tabs, or 
spaces.  This option also applies to the header, if one is requested.  
 
As an example, if "Header Style" is set to "Field Names Only" and "Item Separator" is set to "Comma", the resulting ASCII 
file should be readable by Excel or other utilities that understand CSV ("comma separated value") formatted files. 
 
The "Indicate flags with:" text box allows the user to choose what gets printed if an IEEE-754 "NaN", "Inf", or other non-
numeric floating point value is encountered during the conversion to ASCII.  We suggest keeping the default text "NaN". 
(The term "flag" is used because in some situations, TDAS inserts NaN values to "flag" missing or invalid data samples.) 
 
"Update document with location of data" is not yet implemented in this release (and perhaps never will be), and should be 
disregarded for now. 
 
The suggested workflow for this dialog is to first use the tree widget in the "Loaded Data" pane to select some subset of the 
currently loaded variables, then use the controls on the right hand side to select a file format, an optional time range, and any 
additional style settings (if ASCII format is selected).  Clicking the "Save" button will perform a few checks on the selected 
data variables, and if the selection is valid, the GUI will pop up a file picker dialog to specify the filename and directory to 
save. 
 
Caveats: 
 
This dialog does not permit saving arbitrary collections of variables.  Owing to the record-oriented structure of these file 
formats, all selected variables must contain the same number of samples.  For UCLA upper flat file format, the only valid 
data types are 4-byte integers, and 4- and 8-byte floating-point values.  THEMIS data represented as bytes or 16-bit integers 
(for example, ASK) cannot be saved as UCLA upper flat files.  These restrictions are enforced at the very end of the 
workflow, when the user clicks "Save".  The first variable name with an incompatible sample count or data type will be 
mentioned in the error message; try removing that variable from the selection, and repeat the process until a valid ensemble 
of variables remains. 
 
ASCII files generated from large data sets (e.g. several hours of ASK keogram data) are potentially enormous, and may 
appear to lock up  IDL for a long time while the file is being written.  Even modest ASCII data sets may require several 
minutes to be saved.  These operations are somewhat inefficient; due to the need for column-by-column checking, formatting, 
and output of data fields. 

6.3.7 Manage Data and Import/Export Tplot 
 
The Manage Data Window allows you to import TPLOT variables into the GUI, export TPLOT variables from the GUI, 
delete GUI variables, and view/edit the meta-data associated with various GUI variables.   
 
To import TPLOT variables you can select one or many (ctrl/shift-click) tplot variables in the left TPLOT Data area, then 
press the right arrow button to move data into the GUI.   The data will then be moved into the GUI and attempt to detect the 
variable meta-data that includes name, mission, observatory, instrument, units, and coordinate system.  Figure 6.3.7a shows 
the Manage Data window. 
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When the right arrow is clicked to import tplot data, the Verify Data Window will be displayed allowing you to verify that 
this data was correctly detected. Click the OK button if it is or 'Cancel' if you change your mind about importing.  After you 
press 'OK' on the Verify Data panel, the data will be loaded. Figure 6.3.7b shows the Verify Data window. 
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To export GUI variables to TPLOT, select the GUI quantities that you would like to export from the tree at the right and 
select the left arrow button to export them. 
 
To delete GUI variables, select the GUI quantities that you would like to delete from the tree at the right, then select the trash 
can button to delete them. 
 
To examine the meta-data (name, mission, observatory, instrument, units, coordinate system, and file name) associated with 
particular GUI variables. Select the variable to be examined in the tree at the right and select the magnifying glass button to 
examine the meta-data.  A menu like the verify menu will pop-up and you can view or edit the meta-data for the selected 
quantities. 
 

6.3.8 Export Image To File… 
 
The Export to Image Menu allows you to generate an image file of your currently active page.   The THEMIS GUI supports 
the following file types:  Portable Network Graphics (.png), Encapsulated Postscript (.eps), Windows Meta-File (.emf, 
Windows Only), Windows Bitmap (.bmp), Graphics Interchange Format (.gif), Joint Photographic Experts Format/JPEG 
(.jpg), JPEG 2000 (.jp2), Apple PICT format (.pic), Portable Picture Map (.ppm), Sun Raster Format (.srf) . 
 
The EPS export uses the routine ssl_general/misc/fancompress.pro to decrease the size of line plots when exported to EPS. 
EPS files without compression can be tens or even hundreds of MB large.  Fan Compression should generally keep the EPS 
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size down to less than 1 MB. Fan Compression removes redundant data points using an IDL implementation of the algorithm 
described in the paper: Fowell, Richard A. and McNeil, David D. , “Faster Plots by Fan Data-Compression,”  IEEE 
Computer Graphics & Applications, Vol. 9, No. 2,Mar. 1989, pp. 58-66. 
 
EPS files created by the gui with large line resolution percentages may 
take a long time to read in postscript readers. 
The directory to which you will output is listed at the top.  The 'Arrow' button will allow you to move up one directory.  You 
can also edit the directory by typing directly into the directory field, or selecting the desired directory from the directory list 
below. 
 
The file name for output is listed in the text box at the bottom.  Change the output format by selecting a different type from 
the 'Save As' dropdown menu at the bottom.  The 'Options' button will show the graphics output options for the selected file 
type.  These options will change depending on the file type.  They involve things like the size and resolution of the output 
file.   
 
When you are ready to actually save the file, select the 'Save' button, and the requested file will be saved to the selected 
directory.  If you change your mind select the 'Cancel' button or the 'X' in the corner. Figure 6.3.8 shows the Save Image 
window. 
 

 
 

 
NOTES:   

 .EPS and .EMF both support vector output, which is needed if you 
want to resize without pixelation or load the file into Illustrator to 
select individual labels and ticks for editing.   To turn on vector 
output for either of these format types, press the 'Options' button and 
select 'Vector'.   

 Setting line plot resolution at or past 70% can make the file 
unreadable due to the size of the file.  

 

 

 
 

 

6.3.9 Print 
 
When the Print option is selected under the File pull down menu an IDL print dialog window will be displayed. The default 
print device will be displayed and you can choose the number of copies you would like printed out.  If you do not wish to use 
the default printer listed, please see Section 6.3.11, Printer Setup, which allows you to select from all printers that are 
recognized by your system. In addition, the Printer Setup window allows the user to control additional print parameters.  
 
Figure 6.3.9 shows an example of the print dialog window. 
 

Figure 6.3.8 
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NOTE Printing in IDL can be unreliable depending on your combination of Printer and OS.  If you have any 
problems printing, you should export your document to an Image(EPS or PNG) and print directly using your an OS 
specific image viewer. 
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6.3.10 Print Setup 
 
The Printer Setup option available under the File pull down menu allows the user to set up print parameters, select print 
devices, and print. The Print Setup option displays the standard IDL print dialog window.  All print devices that your system 
can detect are listed in the Select Printer box. In addition, you can control the number of copies, page range, collating details, 
and preferences associated with the print device you selected. For detailed information about this dialog box and the 
preferences you can set, please refer to the IDL User’s Guide. Figure 6.3.10 shows the Print Setup window. 
 

 
 

6.3.11 Configuration Settings… 
 
This button pops up a window that allows access to the system variables that control the automatic downloading process. You 
can type in values for the different options in the window.  Tabs at the top of screen allow selection of configuration 
parameters for the different missions that the GUI supports loading data from. 
 
The top window gives the local data directory. THEMIS data that are downloaded are written to this directory. The default 
value for users who are logged on to an ssl.berkeley.edu machine is "/disks/data/themis/". For windows users, the default 
value is "C:\data\themis\". It can be set to any directory for which the user has write permission. 
 
The second text box shows the remote data directory. The default is http://themis.ssl.berkeley.edu/data/themis/ 
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Next is the control for utomatic downloads. (This should be set to "Use Local Data Only" for local SSL users, or anybody 
who has the entire database stored locally). 
 
Next is the control for file updates.  If turned on, a file will be redownloaded if a file with a newer timestamp is found in the 
remote data directory.  If turned off, files will only be downloaded if they are not stored locally. 
 
The graphics mode allows you to select whether the graphics rendered are done with hardware or software. Rendering of 
graphics varies based on your system and platform. If your graphics are slow to display, you might want to switch your 
graphics mode.  Our testing has found that software rendering generally provides faster graphics with fewer artifacts.  
 
The verbose flag controls the number of messages that will be displayed. Set this to a number from 0 to 10. The higher the 
number, the more messages you get during processing. The Configuration Settings window is show below in Figure 6.3.11 
 
 

 
 
 

RESET - If you press this button, configuration settings are returned to their original state prior to opening this window. 
 
RESET TO DEFAULT - If you press this button, the configuration is returned to the default state in THM_CONFIG.pro, and 
any saved configuration file is deleted. This means that if you want to go back to a configuration that you have saved 
previously, you need to reset the values and then save the configuration. Alternatively, you can locate the previously saved 
file and copy it to the appropriate location in the APP_USER_DIR shown below. 
 
SAVE - If this button is pressed, then the current configuration is saved in a file. This file ends up in a directory created by 
the IDL APP_USER_DIR routine, on a windows system the path looks like this: "C:\usernme\.idl\themis\thm_config-4-
win32\thm_config.txt". On a linux machine, it looks like: "$HOME/.idl/themis/thm_config-4-linux/thm_config.txt" 
 

Figure 6.3.11 
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Important:  Once you have saved this file, it will always be read when you run any THEMIS routines -- you should only need 
to do this once for each operating system that you are using.  
 
Whenever you save a new file, the old file is copied to a file tagged with the current date and time, for retrieval in case of 
disaster. 

 
6.3.12 Overview Plot  
 
The Generate THEMIS Overview Plot menu option will create mission overview plots of all instruments. When this option is 
selected a window will be opened that allows the user to specify which probe (a-e) and time range are used to create the plots. 
Since a significant amount of data is required to generate these plots, it might take several minutes to load all the necessary 
data. The user should also be aware that ESA & State data stored in IDL common blocks will be deleted. If you plan on 
command line particle spectra, moments, or coordinate transformation routines, you should reload the data for the time 
interval in question.  Figure 6.3.12.a shows the overview plot window and figure 6.3.12.b contains the overview plot. 
 
 

 
 
 
 

Figure 6.3.12.a 
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6.3.13 Exit 
 
The Exit option under the File pull down menu will terminate the THEMIS GUI session. All windows will be closed and 
control returned to the command line.  
 

6.4 Edit Menu 
 
The Edit menu contains options that allow the user to copy images or pages and delete or zoom into marked areas. Figure 6.4 
shows the Edit pull down menu selections. 
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6.4.1 Copy 
 
The Copy option in the Edit pull down menu will place a copy of the current or ‘active’ page on the clipboard.  You may also 
use the accelerator key sequence Ctrl-C to copy the current page. Once the image has been placed on the clipboard, the user 
may paste it into any program, such as a Word document. 
 

6.4.2 Delete Marker 
  
If markers exist and one has been selected, the Delete Marker option under the Edit pull down menu will remove the marker 
and redraw the page without the marker. Recall that when a marker is selected, the vertical lines bounding the marked area 
are drawn in blue. If no markers exist, or none have been selected the procedure will do nothing and you can continue with 
other GUI operations. 
 

6.4.3 Subset 
 
The Subset option will create a new page based on the ‘active’ window or the selected marker. This menu item contains two 
submenus, Page and Marker.  
 
The first item, Page, makes a copy of the ‘active’ page and pastes that copy into a new page.  The original page is preserved. 
You can use the Page pull down menu to toggle back and forth between pages. 
 
The second item, Marker, zooms in to the selected marker. Like with Subset Page, the Subset marker option will create a new 
page, this time containing only the x range that is contained within the marker boundary. The original page is preserved.  
 

6.5 View Menu 
 
The View menu contains items that modify the look of the main GUI window and/or the page and panels displayed in the 
main graph area. 
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6.5.1 Refresh 
 
You can use the Refresh option in the View pull down menu at any time to redraw the ‘active’ page. The Refresh option also 
has an accelerator key, Ctrl-R. 
 

6.5.2 Scroll Forward/Backward 
  
Scrolling can be invoked in three ways, using the Scroll Forward or Scroll Backward option in the View pull down menu, 
using the left and right arrow keys, or by using the scroll icons in the toolbar. A scroll request will move the x-axis forward or 
backward by the range of a major tick. This operation will be done for all panels in the ‘active’ page. 
 

6.5.3 Expand/Reduce 
 
Similar to scrolling the Scrolling forward can be invoked in three ways, using the Scroll Forward or Scroll Backward option 
in the View pull down menu, using the ctrl and tab keys, or by using the expand/reduce icons in the toolbar. A expand/reduce 
request will expand/contract the x-axis of the displayed data by a major tick. 
  

6.5.4 History Window  
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The history window is a list of the steps, operations, and plots that have been executed during the course of your session, as 
well as warning and error messages. Just below the history window are buttons that allow the user to save the history in a file, 
and clear the history. The "Save" button will save the history in an IDL source file. When you click here, a file selection 
window pops up, allowing you to choose the filename and path for the file. The default file is 
"thm_gui_history_yyyymmddss.pro" and is located in your local working directory. The time stamp on the default file name 
is the local system time. The "Close" button close the history window. History window messages are not lost when the 
window is closed. History messages are recorded at all times while the THEMIS GUI is running, regardless of whether the 
window is displayed or not. 
 
Since the history information includes error message, it will be used as a debugging tool. When an unexpected error is 
encountered during your session, you will be notified with a message and the Error Report Form will be displayed. When the 
Save button is clicked in the Error Report window both the Error Report Form and the History file when the Save button is 
clicked in the History window only the history file is saved. In addition to history messages, IDL journal messages will also 
be appended to the file.   
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6.5.5 Position Legend 
 
The Position Legend is the box in the upper right hand corner of each panel displayed in the ‘active’ page. The legend box 
displays a value for each variable within the panel. The value displayed is the value at the point where the vertical tracking 
line intersects the data line, in other words the x value of the data at the x position of the cursor. Whenever the cursor is 
moved the values in the legend box will be updated. Note that along with the y-axis labels, the legend labels and values are 
color-coded and synchronized with the color of the line within the plot. Figure 6.5.5a below shows an example of the legend 
box. 
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The legend box is only on when tracking is enabled. If tracking is enabled and the user can chooses not to display the legend 
box, they can turn the legend on and off by toggling the Position Legend option selection in the View pull down menu. The 
Position Legend is a checked marked menu item, when a check mark appears to the left of the menu name the position legend 
will be shown, no check mark indicates that the legend is off. Figure 6.5.5b below shows an example of a page with the 
position legend turned off.   

 

Position 
Legend 

Figure 6.5.5a 
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It is worth noting that when a page is sent to a print device, the legend will not appear in the hard copy so that the area 
covered by the legend box can be seen. 
 

6.5.6 Status Bar  
 
At the bottom of the main GUI window is a status bar. The status bar displays text messages that provide information 
regarding the state of the GUI, the status of an operation, and other updates that are of interest to the user. If, during the 
course of your session, you have an unexpected result, it is worth checking the status bar. Most messages sent to the message 
bar are also recorded in the History message buffer. In the event that an expected error occurs due to incorrect usage of the 
GUI or request of an operation not allowed at that time you will be informed with an IDL dialog box. The dialog is popped 
up and you will need to either acknowledge the message or respond with a yes or no.   
 

6.6 Graph Menu 
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6.6.1 Panel Tracking 
 
Tracking can be toggled on or off by selecting the Panel Tracking option under the Graph menu. When tracking is on, you 
will see a vertical bar tracking any cursor movement that occurs inside the frame of a panel. This option is a checked menu 
item. When a check mark is displayed before the menu item name, Panel Tracking, then you will see the vertical line. When 
no check mark is present tracking is turned off. By turning off tracking, you also turn off the position legend box in the upper 
right corners of the panels.  This menu item will also turn off the Track One Panel and Track All options. 
 

6.6.2 Track One Panel  
 
The user can choose to turn the vertical tracking line to track only one panel at a time versus all panels. When this mode is 
selected the vertical tracking bar will track only the panel that the cursor is in. Similarly, if the position legend is on, only the 
legend box of the panel the cursor is in will be updated. This is a checked menu item and is on when the check mark is 
present and off when not. When tracking is in one panel mode, the track all option will automatically be turned off and the 
menu item will be unchecked. The Track One/Track All menu pairs are mutually exclusive so when one mode is on, the other 
will be turned off.  
 

Figure 6.6 
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6.6.3 Track All 
 
When in track all mode, the vertical line will track the cursor movement in all panels in the ‘active’ page. See section 6.6.2 
Track One Panel to see how the two menu items are paired.  
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6.6.4 Vertical Tracking  
 
Currently the tracking line is only displayed vertically. This menu item will be turned on whenever tracking is on, and off 
when tracking is off. This is regardless of whether tracking one panel or all panels. Future versions may implement horizontal 
tracking as well.  
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6.6.5 Horizontal Tracking  
 
Currently the tracking line is only displayed vertically. This menu item will be turned on whenever tracking is on, and off 
when tracking is off. This is regardless of whether tracking one panel or all panels. Future versions may implement horizontal 
tracking as well.  
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6.6.6 Plot/Layout Options 
 
The Plot/Layout Options window allows the user to create panels and select data values for display on those panels. Panels 
can be added, deleted, and reordered. In addition, settings associated with panels and traces can be modified. 
 
The left hand side of the window is used for selecting the independent and dependent variables to be used in plots. The right 
hand side of the window is for manipulating panels. If no data has been loaded or panels created both these text areas will be 
blank. The Variable section at the bottom of the window allows the user to select variables for display below axes. 
 
There are two types of plots supported: Linear and Spectral.  To add a plot of a particular type, select the data that you want 
to add and select the line or spectra button.  If you check "Show Data Components", you can select the data used to generate 
the x,y, & z(spectra-only) axes of the plots.  Figures 6.6.5a and 6.6.5b show examples of both.  
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If no panels exist, one will be created automatically and named, Panel 1(1,1).  For subsequent plots, you will need to select a 
panel that already exists or add a new panel by selecting the "add" button under the panels heading.  
 
As new panels are added the panel number will increase sequentially, regardless of whether earlier panels were deleted or 
reordered. The row and column numbers are displayed in parenthesis next to the panel number.  It is important to note that 
Panel numbers do not change, however, row and column values can 
 
The user can choose to delete a panel or trace by selecting (or highlighting) the item in the panel text box and clicking delete. 
Further, the user can modify panel or trace settings by selecting the item and clicking the Edit button.  See Sections 6.6.5.1 
and 6.6.5.2 for additional details. 
 
The Up and Down arrow buttons provide a way to reorder panel rows or trace location on the panel. The left and right arrow 
buttons move panels by column. Panels can be overlaid, in other words, they can have the same row and column number. The 
user needs to be aware of this feature when reordering so that care can be taken to ensure the correct layout is created.  
 
The row and column number of a panel can be changed using the Row and Column spinner widgets below the arrow buttons. 
The total number of rows and columns per page can also be modified. Please note that the total number of page rows and/or 
columns cannot be set to a value less than the largest row and/or column value (e.g. Panel 4(5, 2) – Panel 4 is displayed in 
row 5, the user cannot change the total rows to any value smaller than 5, likewise, in this example, total page columns must 
be greater than or equal to 2). 
 

Figure 6.6.6a 
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A new feature is available that allows you to lock the x-axis to a selected panel. To do this, select the panel you wish to lock 
to and click the Lock to Panel button in the bottom right corner of the window. The panel that all others are locked to will 
have an ‘(L)’ preceding the panel name. When locked the x-axis annotations are only displayed on the last or bottom panel. 
 
The default mode for this window is that the x-axis is time and the y-axis data. The user can choose to show all data 
components by clicking the Show Data Components check box at the top of the window. When checked, a new tab for the X-
axis data will be displayed. In this mode the user can specifically select any x and y data values that have been loaded. You 
must remember to return to the Y-axis tab and make a selection before clicking the Add button. Figure 6.6.6.b shows the 
Layout Options window in the Show Data Components mode. 
 
 

 
 
 
 
At any time the user can click the Apply button to view the panel layout, the OK button to commit the layout, and close the 
window, or Cancel to undo changes and close the window. 
 
At the bottom of the Layout Panel is a variable section. The text box will display any variables that have been chosen for 
display below the x-axis. The user can also click the Add/Edit button to bring up the Variable Options window. See section 
6.6.10 for details on creating variables for display.  

6.6.6.1 Line Options 
 

Figure 6.6.6b 
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When a trace (or line) is highlighted in the panel window and the Edit button clicked the Line Options window will be 
opened. The Line Options window allows the user to modify any settings that are associated with plotting the line. The Edit 
button is for traces only and will not open if a panel is selected.   
 
Line Options can also be opened from the Graph pull down menu. 
 
At the top of the window the user can change the panel and x and y-axes, the window will default to whatever the user 
selected in the Plot/Layout Options window. Once a trace is selected each widget will be updated to show the current settings 
for that trace. Line and symbol settings, as well as symbol frequency can be modified on this window. Figure 6.6.5.1 shows 
the Line Options window. 
 

 
 
Line Modifications  
 

Show: The show check box determines whether the line is displayed or not. A check indicates the line will be 
drawn. 
 
Mirror:  The mirror check box will draw a horizontal line at zero and reflect the trace below.  
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Color: The color button will open the color palette allowing the user to select a different color. When a new color 
has been accepted the current color swatch next to the button will be updated to reflect the change. If the Apply or 
OK buttons are clicked the trace will be drawn in the new color. 

  
Style: The line style drop list contains all the line styles that IDL allows (e.g. dashed, dotted, etc..).  
 
Thickness: The thickness spinner widget lets the user change to size of the line.  
 

Symbol Modifications 
 

Show: The show check box will determine whether the symbol is displayed in the plot, or not. A checked box 
indicates the symbol will be drawn. 
 
Fill: Fill has not yet been implemented, however, when checked the symbol will be filled in with the selected color. 

 
Style: The symbol style drop list lets the user choose any of the symbols that IDL allows. 
 
Color: The color button will open the color palette allowing the user to select a different color. When a new color 
has been accepted the current color swatch next to the button will be updated to reflect the change. If the Apply or 
OK buttons are clicked the symbol will be drawn in the new color. 

 
Size: The size spinner allows the user to increase or decrease the display size of the symbol. 

Symbol frequency has five options for determining when a symbol is drawn and include:  First Point, First and Last Point, 
Last Point, Major Ticks, or Every x points. If the Every x points button is clicked a numeric value can be specified in the 
spinner widget (e.g. a value of 20 will plot a symbol every 20th point).  

As with all graph options windows, the user can click the OK, Apply, or Cancel at any time. 
 

6.6.7 Page Options  
 
The Page Options window controls settings global to the current page. To open this window Select Page Options in the 
Graph pull down menu. 
 
The Text tab (shown below in Figure 6.6.7a) lets the user choose the settings for size, font, and color of the title, variables, 
and footer.  The ‘Token…’ buttons let the user insert a time stamp with a variety of formats into the title/footer (note that the 
GUI inserts the token at the current location of the cursor).  The ‘Format…’ buttons change boldface and italic settings.  The 
Font Style frame controls font, font size, and font color (a color dialog box opens – see Figure) for both title and footer.  Use 
the Show check boxes to hide or show the title and footer. 
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Figure 6.6.7b shows the token options that are available. 

Figure 6.6.7a 
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The Layout tab (shown below in Figure 6.6.7.c) has four active frames: Panel Arrangement, Margins, Canvas Size, and 
Background.  Panel Arrangement: The horizontal and vertical panel spacing sets the horizontal and vertical distance between 
columns and rows (respectively) of the panels.  Margins: The top, left, right, and bottom margins set the distance (in inches) 
from the corresponding edge of the canvas to the nearest panel.  The margins must be at least 0.1 inches.  Canvas size: The 
dimensions of the page in inches.   
 
 

Figure 6.6.7b 
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6.6.8 Panel Options 
 
The Panel Options window allows the user to modify the layout, spacing, and color of the panel. 
 
There are four ways in which the row and column configuration can be modified. The row and column spinner widgets allow 
the user to specify the row/column they want the selected panel to be drawn on. The row and column span determine how 
many rows or columns the user wishes the panel to for.  
 
Properties associated with the panel frame, color, and thickness as well as back ground color can also be controlled here. If 
you wish to apply your modifications to all panels on the current page you can check the Set All Panels box.  At any time the 
OK, Apply, or Cancel button can be clicked to commit, view, or undo the changes.  Figure 6.6.8 shows the Panel Options 
window Trace tab. 
 
 

Figure 6.6.7c 
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6.6.9 X/Y Axis Options  
 
The X-Axis Options window controls the x-axis settings for the selected panel (use the panel drop down menu at the top of 
the window to change the selection).  To get X-Axis Options, select it from the Graph pull down menu. Accepting and 
canceling changes: Clicking OK accepts the changes and refreshes the page.  Clicking Apply accepts the changes 
provisionally and refreshes the page.  Clicking Cancel rejects any changes and refreshes the page.  Dismissing the window 
via the operating system (‘X’ button) has the same effect as clicking Cancel. 
 
The Range tab sets how the GUI determines the displayed range and gives a special option for when the axis displays time.  
If the axis is time, then the ‘Is Time’ check box should be set.  When the axis is time, then only the fixed Min/Max frame, 
and the Set All Panels button are active.  (A note about Set All Panels: This button works individually for each tab.  Any 
operations done on a given tab after setting the button will propagate to all panels.  Behavior with Locked X-Axes on the X-
Axis only: When Locked X-Axes in Plot/Layout Options is checked [the default], the GUI will check Set All Panels for the 
Range, Ticks, and Grid tabs, while unchecking Set All Panels for the Annotation and Labels tabs.  We recommend that the 
user keeps these settings for the Annotation and Labels tabs when axes are locked.)  When the axis is time, the GUI 
represents the Min/Max range in date/time format.  When the data is not time (uncheck Is Time), the Range and Scaling 

Figure 6.6.8 
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sections become active.  The Range Options buttons now make active (only one at a time) the following frames: Auto Range, 
Floating Center, and Fixed Min/Max. 
 
Auto Range: The range margin sets a margin between the plotted data and the plot box edge (above and below) as a 
percentage of the maximum minus the minimum of the displayed data.  The bound auto-scaling range puts absolute limits on 
how big the range can get; auto-ranges fully within the bounds are unaffected.   
 
Floating Center: The GUI determines the center as a mean, or median of the data (the approximate mean/median options 
currently function identically to the mean/median options.).   If the axis uses linear scaling then floating range is calculated 
using the following equations.  Minimum Range = center – span,  Maximum Range = center + span.  If the axis uses 
logarithmic scaling then the floating range is calculated using the following equations:  Minimum Range = base ^ 
(log(center) – span), Maximum Range = base ^ (log(center) + span).    In other words, the span of the floating center on a 
logarithmic plot is the number of orders of magnitude above and below the center that should be included in the plot. 
In the equation above 'base' is either e or 10, and 'log' is either the natural logarithm or the base 10 logarithm, depending upon 
the type of log scaling that is used. 
 
 
If the axis is Fixed Min/Max: The user determines an absolute range.   
 
Scaling: The user can select linear, logarithmic base 10, or natural logarithmic scaling. Figure 6.6.9a shows the Range Tab of 
the X/Y Axis Options window. 
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The Ticks tab sets where and how to draw the axis ticks, and contains two frames for Placement and Length The user can 
choose to manipulate ticks by number, or by interval. When the ‘Major Ticks by Number’ radio button is on, the user can 
modify the number of ticks in the spinner. .  By default, the GUI determines ticks automatically, however, the user can toggle 
this feature on or off. Please note that when Aesthetic Ticks are on, the # of minor ticks will have no effect. Alternately, the 
user can elect to manipulate ticks by interval. When the ‘Major Ticks by Interval’ button is on, the user can enter the number, 
the units, and/or the specific time at which to align ticks.  If the axis is time, ‘Units’ sets the tick frequency in common time 
units, otherwise the units widget is not active. The ‘Draw Ticks’ drop list provides for different tick style’s and includes 
drawing the tick inside the panel frame, outside the panel frame, or both. The Placement frame has right and left buttons that 
switch ticks on/off for the right and left y-axes of the plot box.  The Length frame controls the lengths of the major and minor 
axes. Figure 6.6.8b shows the Ticks Tab of the X/Y Axis Options window. 
 
Tick options will be measured in orders of magnitude of data units if the axis is logarithmically scaled and data units if the 
axis is linearly scaled.   
 
Here are some examples that explain how these options work: 
 

1. If the axis has linear scaling, the minimum range of the axis is 50, the maximum range of the axis is 100, the 'Major 
Tick Every' is 10, major ticks will be placed at 55, 65,75,85, and 95. 

2. If the range of the axis is from 10^1 to 10^6, the axis has base 10 logarithmic scaling and 'Major Tick Every' = 2.  
Then major ticks will be placed at 10^2,10^4 and 10^6.  
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NOTE:  When auto-ticks are chosen the number of ticks is an upper bound. The actual number of ticks will be determined 
based on the range of the data.  
 
There is also an option to select the style of logarithmic minor ticks.(Log Minor Tick Type) : 
 
Full Interval will generate a logarithmic spaced set of minor ticks that cover the entire distance between major ticks even if 
they have greater than one order of magnitude spacing or non integer number of order of magnitude spacing.  If this setting is 
used, the selected values for the minor ticks may not correspond to obvious values.   
  
First Magnitude will generate a logarithmic spaced set of minor ticks that will start at the lower major tick and count upward 
one order of magnitude.  This may mean that there will not be minor ticks for the full interval, or that they may seem 
compressed, but they will fall at obvious values.  For example, if major ticks are at 1 and 100, and there are 8 minor ticks, 
then minor ticks will be placed at 2,3,4,5,6,7,8,9 
 
Last Magnitude will generate a logarithmic spaced set of minor ticks that will start at the higher major tick and count 
downward one order of magnitude.  This may mean that there will not be minor ticks for the full interval, or that they may 
seem compressed, but they will fall at obvious values.  For example, if major ticks are at 1 and 100, and there are 8 minor 
ticks, then minor ticks will be placed at 20,30,40,50,60,70,80,90 
 
Even Spacing will spaced ticks evenly.  For example, if major ticks are at 1 and 100, and there are 9 minor ticks, then minor 
ticks will be placed at 10^.2,10^.4,10^.6,10^.8,10^1,10^1.2,10^1.4,10^1.6,10^1.8 
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The Grid tab has a setting for the Panel Frame Thickness (which includes the tick thickness), and two frames to implement 
Major and Minor Grids (color, thickness, and style). Figure 6.6.9c shows the Grid Tab. 
 
 

Figure 6.6.9b 
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The Annotation tab allows control over annotation settings for the major ticks.  This tab can also draw a single line at axis 
zero (checkbox).  (Note that the line appears at axis 1 for logarithmic scaling.)  The annotation format dropdown has a variety 
of format options and the GUI provides time formats when the axis is time.  The user can also choose to annotate the first 
and/or the last tick (‘Annotate first’/’Annotate last’).  (Note that the first/last tick often coincides with the edges of the plot 
box.)  Annotation options for numerical data include auto formatting, decimal notation, and scientific. The default is auto-
format. Check ‘Show Date’ to show the date (in the lower left corner of the panel region) and control its format.  Check 
‘Annotate Along Axis’ to control the placement (top or bottom x-axis), frequency, orientation, font, font size, and color of the 
x-axis annotations. Figure 6.6.9.d shows the X Axis options annotation tab. 
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Other annotation options include where to place the annotations, orientation, font type, size and color. Annotation precision, 
by default, will be calculated automatically. The user can specify numerical or exponential format by clicking in the radio 
buttons directly below the annotation Figure 6.6.9.d1 below shows the list of codes that are available for adding to text lines 1 
and 2. 
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The Labels tab controls whether the labels are shown and/or stacked.  Check both ‘Show Labels’ and ‘Show Label’ to display 
a label.  The Style frame sets orientation and margin (globally to the given axis and panel), and font, format, font size, and 
color (for individual labels). The Labels Tab on the X/Y Axis Options window is shown below in Figure 6.6.9e 
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The Y-Axis Options window has an additional feature that the X-Axis Options does not. The user can choose to set all Labels 
to black.  By default the line color and label color are synced on the y axis,  the Set All Labels Black allows the user to 
override the default colors. This can be useful in printing publication plots. 
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6.6.10 Z Axis Options 
 
The THEMIS GUI allows graphing of three-dimensional spectral quantities from the spacecraft as well as ground-based 
keograms.  See the Section 6.6.5 Plot/Layout Options for details on graphing spectra. The second panel in Figure 6.6.10a 
shows an example of spectral data. 
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Once spectral plots are created their extra display features and parameters can be edited in the Z Axis Options found under 
the Graph pull down menu in the main window.  Options for the X and Y-axes are still functional and can also be found 
under the Graph pull down menu. 
 
Settings: 
 
The Settings tab (figure 6.6.10b) contains display and annotation options.  The Panels drop list contains all plots in the active 
page that have z-axes.  
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Color Table:  The color table section allows the user to change the color scheme being mapped to z-axis values on the active 
panel.  A preview of the current selection can be seen on the right.  The color bar represents numerical values in decreasing 
order from top to bottom. Colors are mapped to numerical values according to the chosen Scaling. 
 
Scaling:  Determines how the selected Color Table is mapped to z-axis values.  Values within the range are assigned linearly 
by default but can be assigned according to a base-ten or natural logarithmic scale. 
 
Placement:  Sets the position of the Color Bar (see fig. 6.6.10a).  The Color Bar displays the color scheme of the associated 
panel plus numeric annotations for scaling. 

Figure 6.6.10b 
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Number Ticks:  The number of “ticks” (i.e. scaling annotations) that are displayed along the Color Bar.  Ticks will only be 
displayed if the Color Bar is present. 
 
Margin:  The distance, in number of pixels, between the plot area and the Color Bar. 
 
 
Range:  The z-axis range is automatically calculated by default and the color table is mapped with the selected scaling.  
Checking the Fixed Min/Max box allows the user to specify the maximum and minimum values for the plot.  Values above or 
below the limits are respectively assigned the color corresponding to the maximum or minimum value. 
 
Log Minor Tick Type:  Determines the way that logarithmic minor ticks are spaced on the Z-axis.(See section 6.6.9: X/Y 
Axis Options for description of options) 
 
Text: 
 
The text tab (figure 6.6.10c) contains options for formatting z-axis annotations and adding/formatting z-axis labels.  The 
Panels drop list contains all plots in the active page that have z-axes. IDL style formatting for z axis labels was added in 
releases after 5.1-1. 
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Label 

 
Text:  Enter text here to create a label for the Color Bar. 
 
Font:  Select the font for the text entered into the Text box to be displayed in. 
 
Format:  Select formatting options for Label text such as bold and italic. 
 
Size:  The font size for the Label text. 
 
Color:  The color button will open the color palette for selecting the color of the Label text.   
 
Label Margin: The label margin spinner sets the size of the margin before the Label. Margin values are in points.  
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Orientation: Labels can be drawn horizontally or vertically. 
 
Annotation 

 
The annotation section allows the user to set the same parameters as Labels with the exception of entering text and setting 
annotation margins.  Annotation precision, by default, will be calculated automatically. The user can specify numerical or 
exponential format by clicking in the radio buttons directly below the annotation 
 

6.6.11 Variable Options 
 
The Variable Options window (see Figure 6.6.11a below) lets the user add variables beneath the selected panel.  To get 
Variable Options, select it from the Graph pull down menu. Accepting and canceling changes: Clicking OK accepts the 
changes and refreshes the page.  Clicking Cancel rejects any changes.  Dismissing the window via the operating system (‘X’ 
button) has the same effect as clicking Cancel.  The Apply button allows users to view the changes without closing the 
window.  Hitting "cancel" will undo applied changes. Figure 6.6.11a shows an example of the Variable Options window.  
 
Note that formatting options for the variables (font, style, color) can also be controlled from the page options window. 
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The Attributes frame: The Field attribute shows the proper data name of the variable and never changes.  The Control 
attribute shows which data name represents the abscissa for the variable.  By default, the GUI sets the control to the time data 
for the Field.  The Text attribute changes the name of the variable as displayed in the Variables frame on the left and on the 
plotted panel. The Precision attribute sets the format of the variable annotations (time formats for time variables, floating 
formats for numeric variables).  Precision, by default, is calculated automatically, however, the user can choose to override 
the default settings by selecting either the numerical or exponential radio buttons. The color attributes set the color of the 
selected variable.  The ‘Include units in label’ check box currently has no effect.  Use the ‘Show Variable’ check box to show 
or hide a variable on the plot.  Status information on the window operations appears in the status bar at the bottom of the 
window. 
 
To add variables, click the add button (‘+’).  The ‘Add Variable(s)’ dialog appears with a tree view of the loaded data.  Select 
individual data products, or entire branches.  Shift-click or ctrl-click to select ranges or elements.  Click OK to accept the 
selections, or Cancel to start over.  Any selections now appear in the Variables frame on the left.  Click OK to accept and 
have these variables appear below the current panel, or Cancel to exit Variable Options with no changes.  The user may also  
select a variable (click on it) to change its attributes (see the Attributes frame on the right), to delete it (‘-‘ button), or to 
change its position in the list (up and down arrows).  The Label Margin (below Attributes) changes the margin between all 
variables (for the selected panel) and the left y-axis of the plot box, and also changes the margin between the variable legend 
and the right y-axis of the plot box. An example of the Add Variable window is shown below in Figure 6.6.11b. 
   

 
 
 
A note on locking axes: The GUI hides all variables except those on the last panel when ‘Lock X-Axes’ is checked (see 
Plot/Layout Options on the Graph pull down menu).  This behavior may be modified in later versions. 



 
 
 
 

 

NAS5-02099 File: THEMIS_Science_Data_Analysis_Software_Users_Guide   71   

 
 

6.7 Analysis Menu  
 
The Analysis pull down menu contains selections that allow you to perform various functions on data. Figure 6.7 shows the 
Analysis Menu options. 
 

 

6.7.1 Calculate 
 
The Calculate Window allows you to access a built in language that will perform simple vector operations on GUI data. The 
Syntax of the language itself is described in section 5 of the manual.   Commands for the language can be typed into the text 
box on the left.  Each line will be treated as a separate line.  If you want to insert a particular data quantity, just select the 
quantity from the menu at the right and the quantity will be added to the program text box.  You can also insert variables that 
store the values of numerical constants by selecting them from the drop list in the lower right corner of the window.  On the 
far right side of the window, are drop lists containing common ideal functions and operators.  By clicking on an item in the 
drop list, the function or operator will be inserted into the text box at the last position of the cursor. 
 
Rather than typing your commands in the GUI you can also type a GUI program in a plain text file and load it into the GUI 
by selecting the 'Open' button at the bottom.  If you want to save the program that you currently have in the text box, select 
the 'Save' button at the bottom of the window.  
 
When you are ready to run the program, select the 'Run' button at the bottom and the Calculate program will be executed.  
Any quantities that are created will be automatically loaded into the GUI, but if they are much different from the quantities 
that they came from you may want to double check their meta-data in the manage data menu.   
 
To exit this window, click on the 'X' in the upper right hand corner of the window or the 'OK' button at the bottom of the 
window. The Calculate window is shown in Figure 6.7.1.  
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6.7.2 Nudge  
 
The Nudge Traces option allows the user to “nudge” a trace on a line plot.  “Nudging” simply shifts the given trace by a 
specified amount of time. To activate, select “Nudge Traces” from the “Analysis” pull-down menu on the Main GUI. Note 
that you need to have created a page and panel and plotted some data before anything will happen when you make this 
selection. If there has been data plotted, then a window will pop up, allowing you to select the panel, and trace that will be 
nudged. An example of this window is shown below. There are two drop-down menus that allow you to select the panel and 
trace that will be nudged. For the current selection, panel 1 is selected, and the trace “tha_state_pos_x” is selected. The units 
(time units or records) are selected on the right side of the panel; in the example the shift will be given in hours. The number 
of hours (or minutes, or seconds, etc…) can be selected in the window below the trace selection window. Note that you can 
type a value into this window as well as use the arrows on the side to scroll values.  
 
When the “Apply” button is clicked, the trace is shifted. This is accomplished by creation of a new variable. The amount of 
the shift is recorded in the variable name to avoid confusion, to allow for easy recovery of the original values, and to allow a 
nudged variable to be plotted along with the original. In this example, the new variable name is “tha_state_pos_x_3_hr” and 
is shown on the panel where the nudged trace is plotted.  
 
 



 
 
 
 

 

NAS5-02099 File: THEMIS_Science_Data_Analysis_Software_Users_Guide   73   

 
 
Warning: Note that traces are shifted one at a time. If you are attempting to nudge a spectrogram (e.g, THEMIS ESA or SST 
flux spectrograms, or ASK All Sky Keograms) then you may get unpredictable results when the plot shows up.  
 

6.7.3 Data Processing  
 
When you click on “Data Processing…” on the Analysis pull-down menu on the Main GUI, a window pops up that allows 
you certain data processing tasks.  
 
This window is shown below. On the left side is a window that shows the data that has been loaded. You can click on each 
variable in this window, and set it to “active” by clicking on the right arrow button in between windows. This process works 
both ways; you can set data to “inactive” by clicking on it in the right-hand window and clicking the left arrow button in the 
middle. You also have the option to clear the active data by clicking the “Clear Active” button. Data processing tasks are 
only possible when there is “active” data.  
 
In this window, the “active” data set is “tha_fgh”. Any data processing task will affect these data only.  Note that it is not 
possible to select individual traces for data processing; the full variable is processed. 
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A data processing task will change the active data set to be the data that has been just been created, so once a task is finished 
this variable will show up in the right-hand window, and also it will be added to the loaded data tree on the left. Clicking the 
“Done” button closes the window. 

6.7.3.1 Subtract Average  
For each active data set, the average value is subtracted. new variables are created, the new names have the syntax: new_var 
= old_var+"-d", and the new variables become the active data sets`. Note the change in both windows in the figure below, the 
new variable has been added and set to active. 

6.7.3.2 Subtract Median  
For each active data set, the median value is subtracted. new variables are created, the new names have 
the syntax: new_var = old_var+"-m", and the new variables become the active data sets. 

6.7.3.3 Smooth Data 
This process performs boxcar smoothing of the data. A widget will pop up providing options for this operation,  You can 
selecting the resolution of the smoothing window. The default is 61 seconds.  You can also determine whether smoothing is 
done over the data forward from each point in the data, backward from each point in the date, or centered on each point in the 
data.(Default)  The smoothing operation supports automatic interpolation to a specific cadence.  You can also turn on and off 
check boxes determining whether time interpolation is done, whether true time integration is performed, and whether to 
smooth NaNs.  Finally, you can control the suffix on the output.   These options are described in more detail in the header for 
the TDAS routine "smooth_in_time.pro" 
Select "Ok" to process data.   "Cancel" or "X" will close the window without processing. 
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6.7.3.4 High Pass Filter 
Click this button to apply a high-pass filter  to the data.  The options window that pops up allows you to control the width of 
the averaging window used to calculate the low pass(which is subtracted from the data to generate the high pass).  You can 
also automatically interpolate to a specific cadence and control the suffix of the output.    
 
 

 

Figure 6.7.3.3 

Figure 6.7.3. 
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6.7.3.5 Block Average 
Click this button to average that data over time.  The options window that pops up allows control of the width of each block 
over which the average is performed.   The average can also be limited to a subset of  the time range of the data quantities 
being processed.  Finally,  you can control the suffix of the output. 
 
   

 
Figure 6.7.3.5 
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6.7.3.6 Clip 
Clips data of the independent variable(y/z axis) in a group to the selected interval.  The options window that pops up allows 
control over the minimum and the maximum for the clipping.  You can also control whether points adjacent to the out of 
range points are also removed.  "Insert Flag" allows a particular value to replace clipped values.  Finally, "Insert NaNs" 
allows NaNs to be inserted in place of clipped values.  You can also control the suffix appended to the output quantities. 
 

 

 

6.7.3.7 Deflag 
Interpolates or repeats the most recent valid data value over gaps in the data (gaps are denoted by NaNs, and can be created 
by the clipping process; a “deflag” often happens after NaN values are inserted by a “clip” operation). A window pops up to 
control the parameters for the deflag routine.  You can select the method "Repeat Last Value" which will fill flagged regions 
with the value on the boundary of the region, or "Interpolate" which will interpolate between the values at the boundaries of 
flagged regions.   "Set Flag" allows you to specify the value used as the flag, otherwise NaN is assumed.  "Set Maximum 
Gap" determines the maximum size for a flagged region to be deflagged.    You can also control the suffix appended to the 
resulting quantities. 

Figure 6.7.3.6 
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6.7.3.8 Degap 
The degap procedure locates gaps in data, and fills them in with 'NaN' values, so that the plotting process displays the data 
gaps correctly (Otherwise it simply draws a line across the gap). It figures out where to add data points by checking which 
time differences are greater than or equal to an input time interval, plus a margin, and inserts equally spaced 'NaN' data points 
at time intervals with spacing determined by the size of the data gap divided by the number of points that fit with minimum 
cumulative error.   "Set Flag" allows a value other than NaN to be specified as a flag, and "Set Maximum Gap" allows the 
maximum gap size to be flagged to be set.  You can also control the suffix appended to the resulting quantities. 
 

 

Figure 6.7.3.7 

Figure 6.7.3.8 
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6.7.3.9 Clean Spikes 
This process removes large single point spikes from messy data.  Spikes are identified by removing any regions above a 
threshold that are larger than a smoothed signal subtracted from the signal.   The available settings allow control over how 
big the difference over the smoothed curve needs to be, and how large a subset of the curve will be included in the 
smoothing.   You can also control the suffix appended to the resulting quantities. 

 

 

 

6.7.3.10 Time Derivative 
This process takes the time derivative of the active data sets.   The available options allow the data to be smoothed before the 
derivative is calculated, thereby removing very high frequency components in the derivative.  You can also control the suffix 
appended to the resulting quantities. 
 

 

 

6.7.3.11 Wavelet Transform 
The data is split into components, and a basic wavelet transform is performed on each component, with "_wv" appended to 
the old variable names. (Note that this is designed for data that are either electric or magnetic field data type. Applying this to 
other data (e.g., spectrograms) will cause non-intuitive results.) 

Figure 6.7.3.9 

Figure 6.7.3.10 
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Since this process can be very memory-intensive, the user is first asked to specify a time range. A window allows the user to 
input start and end times. 
 
 

 
 
 
 
Note the values shown here are rough estimates of the available memory and estimated memory usage. If they are close, then 
it is advisable to click the “NO” button. The process will continue if the “YES” button is pushed. Typical machines have 1 to 
2 G-bytes of memory as of this writing (Feb-2009), but if there has been data loaded the available memory may be less. For 
Window PCs IDL may be limited to 2 GB or less.  

Figure 6.7.3.11a 

Figure 6.7.3.11b 
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6.7.3.12 Power Spectrum   
When the Power Spectra button is clicked a new window will be opened containing power spectral parameters that the user 
can manipulate. The user can choose between dynamic or time power spectra, and select window size and shift, time range 
and how the data is to be binned. The data is split into components, and a power spectrum is obtained from each component. 
Appended to the original variable names are "_dpwrspc " or "_tpwrspc” depending on the type of power spectra the user 
selected, or a suffix can be selected.   Note that this is designed for data that are either electric or magnetic field data type. 
Applying this to other data (e.g., spectrograms) will cause non-intuitive results.  
 
 

 

 

6.7.3.13 Coordinate Transform 
When the "Coordinate Transform" button is clicked, a dropdown menu appears with different choices for coordinate 
transforms. Each possible output coordinate system has a button.  The possibilities are: "SPG" (Spacecraft Probe 
Coordinates), "SSL" (Spinning Spacecraft Coordinates), "DSL" (Despun Spacecraft Coordinates), "GSE" (Geocentric Solar 
Ecliptic), "GSM" (Geocentric Solar Magnetospheric), "GEI" (Geocentric Earth Inertial), and “SM” (Solar Magnetic). 
 
Only the active data sets are transformed.  The input coordinate systems for the active data sets are automatically obtained.  
Data with "Unknown" coordinates and ground-based data will not be transformed. Note that state data for the appropriate 
THEMIS probe is necessary for the coordinate transform to occur. If it is not present, then a pop-up will alert the user, and 
give the option to load the state data. 
 

Figure 6.7.3.12 
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Click on the "Transform" button to perform the transformation. Warnings and error messages will appear in the text window 
at the bottom, and also in the progress window on the main widget. Click on the "Close" button to dismiss the popup. 
 

6.7.3.14 Interpolate 
Selecting the interpolate button opens a window containing interpolation options. This function uses the standard IDL 
interpolate routines. Besides manipulating the interpolation parameters the user can also limit the time range and specify the 
suffix for the new variable name. Clicking the OK button run the interpolate function on any variables that are in the Active 
Data area on the Data Processing window. 
 
 

 

 

6.8 Page Menu 
 
The Page pull down menu contains options to open, close and toggle between pages. The Page menu options are shown 
below in Figure 6.8.  

Figure 6.7.3.14 
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6.8.1 New 
 
The New option under the Page pull down menu will open a new page. The new page will be blank since no data or panels 
have been selected.  Figure 6.8.1 shows an example of a new page. In addition, the new page will be added to the Page pull 
down menus. To create new panels on this page select the Plot icon button on the tool bar or the Plot/Layout option under the 
Graph menu.  
 

6.8.2 Close 
 
The THEMIS GUI allows the user to have multiple pages.  If you wish to close a page there are several ways this can be 
done. The first is using the Page pull down menu and selecting the Close option. The currently displayed page, or the ‘active’ 
page will be closed. Other pages will still be available. The main graph area will redraw the first page in the list, unless there 
are no more pages, in which case a blank graph area will be drawn. In addition, the Page pull down menu dynamic options 
will be updated and renumbered to reflect the change.  
 
Besides the file pull down menu, you can also type Ctrl-Z or select the Close option under the File pull down menu.   
 
It should be noted that once a page is closed the settings that were associated with that page will be lost, unless you requested 
Save THEMIS Document under the File pull down menu before you closed the page. The data that was plotted in the page 
still remain are available for analysis and plotting. Only the plot settings are deleted. 
 

6.8.3 Pages  
 
The lower portion of the Pages pull down menu contains dynamic menu items and is dependent on the number of pages that 
have been created. Figure 6.8 above, shows an example of the pull down menu with three pages.  Each of the dynamic menu 
items are checked menus. Only one page can be checked or displayed at a time, since only one page can be displayed at a 
time. The user can toggle between pages by simply clicking the page they wish to view. When new pages are created a new 
menu items is added to the list. Likewise, when pages are closed, the menu items are renumbered to reflect the new page 
count. If all pages have been closed, the last page (page one) will be cleared, however it will remain as a blank page. 
Similarly, when the GUI is initialized there a blank page is already created. 
 

6.9    Help Menu 
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The user can view a text version of this document or create a help request form. Figure 6.9 shows the Help pull down menu 
options. 
 

 
 
 

6.9.1 Help Window 
 
Clicking on the Help menu and selecting Help Window… will open a dialog box that will provide you with the URL for the 
online User’s Guide document.  Figure 6.9.1 shows the help dialog window. 
 

 

 
 

6.9.2 Help Request Form 
 
When this button is clicked, a text window pops up displaying the THEMIS Science Help Request Form. This allows the user 
to input information about the error which has occurred. There is a save button, which saves the help request form in a file. In 
addition to the request form a History file will be save containing History window and journaling messages. You will be 
informed where both files are located.  Both files should be emailed to THEMIS_Science_Support@ssl.berkeley.edu. Click 
the Close button to dismiss this widget. 
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6.9.3 Overview Plot Key… 
 
When the Overview Plot Key menu item is selected a window will open with an example of the overview plots. Each panel 
contains a legend or key describing the data that is plotted.  This is a sample window only and does not contain current data. 
It sole purpose is to define for the user the data that is drawn in the overview window. 
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6.10 TPLOT 

6.10.1 Import / Export  
 
The GUI maintains an internal representation of the data for its own use. Data loaded into the GUI directly use the 
thm_load_data routines available in the software distribution. Tplot variables created at the command line can be imported 
into the GUI for internal use, or exported from the GUI for command line use. The Load THEMIS Data and Manage Data 
Import/Export Tplot  items under the File pull down menu provide options to manage the data. See Sections 6.3.5 and 6.3.7 
for further details.  

6.10.2 tplot_gui 
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In addition to importing and exporting tplot variables the user can also plot variables from the command line for display 
within the GUI. Tplot_gui works in the same way that tplot works, however, tplot_gui will display the plot on a new page in 
the GUI graph area. Tplot  used in the original way will display the plot in a new window that is external to the GUI.  For 
example, at the IDL command line you can type the following: 
 
IDL>   tplot_gui, ‘tha_fgl_dsl’  
 
Before drawing the plot, the Verify Data panel will be opened. In order for the GUI to use tplot data it requires the variable 
be imported.  The Verify Data panel simply allows you to check the validity of the tplot meta data. See Section 6.3.7 for 
details on managing, importing, and exporting data. Figure 6.10.2a shows an example of the Verify Data window. 
 

 
 
Once you accept the meta-data values and click the OK button a new page and plot will be created. Figure 6.10.2b shows the 
new plot. 
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Because the default plot mode of the GUI is linear, spectral data will be drawn in linear mode. You can switch to spectral 
mode by using the Plot/Layout Options under the Graph pull down menu, or by clicking the graph icon button on the toolbar.   
 
No changes have been made to the tplot procedure and it functions as it always has.  An example of the IDL command line 
and resulting plot are show below in Figure 6.10.2c 
 
IDL> tplot, ‘tha_gfl_dsl’ 
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